Parallel Port Scanner
Installation Guide

FOR WINDOWS



COPYRIGHT INFORMATION

Copyright © 2000 Visioneer, Inc., a wholly owned subsidiary of Primax Electronics LTD.
Reproduction, adaptation, or translation without prior written permission is prohibited, except as allowed under the copyright laws.

The Visioneer brand name and logo are registered trademarks of Primax Electronics LTD. OneTouch is a trademark of Primax Electronics LTD. The
PaperPort brand name and logo are registered trademarks of ScanSoft, Inc.

Microsoft is a U.S. registered trademark of Microsoft Corporation. Windows is a trademark of Microsoft Corporation. TextBridge is a registered trademark of
Xerox Corporation. ZyINDEX is a registered trademark of ZyLAB International, Inc. ZyINDEX toolkit portions, Copyright © 1990-1998, ZyLAB
International, Inc. All Rights Reserved. All other products mentioned herein may be trademarks of their respective companies.

Information is subject to change without notice and does not represent a commitment on the part of Visioneer. The software described is furnished under a
licensing agreement. The software may be used or copied only in accordance with the terms of such an agreement. It is against the law to copy the software on
any medium except as specifically allowed in the licensing agreement. No part of this document may be reproduced or transmitted in any form or by any
means, electronic or mechanical, including photocopying, recording, or information storage and retrieval systems, or translated to another language, for any
purpose other than the licensee's personal use and as specifically allowed in the licensing agreement, without the express written permission of Visioneer.

Restricted Rights Legend

Use, duplication, or disclosure is subject to restrictions as set forth in contract subdivision (c)(1)(ii) of the Rights in Technical Data and Computer Software
Clause 52.227-FAR14. Material scanned by this product may be protected by governmental laws and other regulations, such as copyright laws. The customer
is solely responsible for complying with all such laws and regulations.

Limited Product Warranty

If you find physical defects in the materials or the workmanship used in making the product described in this document, we will repair, or at our option,
replace, the product at no charge to you, provided you return it (postage prepaid, with proof of your purchase from the original reseller) during the 12-month
period after the date of your original purchase of the product.

THIS IS OUR ONLY WARRANTY AND YOUR EXCLUSIVE REMEDY CONCERNING THE PRODUCT, ALL OTHER REPRESENTATIONS,
WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, WRITTEN OR ORAL, INCLUDING ANY WARRANTY OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE EXPRESSLY EXCLUDED. AS A RESULT, EXCEPT AS SET OUT
ABOVE, THE PRODUCT IS SOLD “AS IS” AND YOU ARE ASSUMING THE ENTIRE RISK AS TO THE PRODUCT'S SUITABILITY TO YOUR
NEEDS, ITS QUALITY AND ITS PERFORMANCE,

IN NO EVENT WILL WE BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING
FROM ANY DEFECT IN THE PRODUCT OR FROM ITS USE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

All exclusions and limitations in this warranty are made only to the extent permitted by applicable law and shall be of no effect to the extent in conflict with the
express requirements of applicable law.

FCC Radio Frequency Interference Statement

This equipment has been tested and found to comply with the limits for the class B digital device, pursuant to part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and if not installed, and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try and correct the interference by one or more of the following measures:
« Reorient or relocate the receiving antenna.

« Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

« Consult the dealer or an experienced radio/TV technician for help.

This equipment has been certified to comply with the limits for a class B computing device, pursuant to FCC Rules. In order to maintain compliance with
FCC regulations, shielded cables must be used with this equipment. Operation with non-approved equipment or unshielded cables is likely to result in
interference to radio and TV reception. The user is cautioned that changes and modifications made to the equipment without the approval of manufacturer
could void the user's authority to operate this equipment.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference,
and (2) this device must accept any interference received, including interference that may cause undesired operation.



TABLE OF CONTENTS

Welcome . ..o 1
What's inthe BoX . ... ..o 1
The Parallel Port Scanner ........... .. i 2
What You Need . . ... 3
Getting the PaperPort Online Documentation ................. 3
GettingHelp .. ... 3
Connecting the Scanner to the Computer ..................... 4
Installing the Scanner Software ............................. 6
SettingUpthe Scanner ....... ... ... . i 7
Scanningan ltem . ... e 8
Adjusting Scanner Settings . .. ... ... 11

Selecting a Predefined Scanner Setting . .................. 12

Selecting Scan Configuration Options .. .................. 13

Customizing a Scanner Setting .. .......... ... 14

Adjusting the Brightness and Contrast ................... 15

Selecting the Area of the Item You Wantto Scan ........... 16
Cleaning the Scanner Glass . ........... .. ... ... 17
Parallel Port Scanner Specifications ......................... 18



WELCOME

Congratulations on purchasing the parallel port, flatbed scanner. With
your scanner, you can quickly scan paper documents and color photos
to place their electronic images on your computer.

WHAT’S IN THE BOX

Before starting the installation, check the contents of the box to make
sure that all parts are included. If any items are missing or damaged,
contact the dealer where you purchased the scanner.

Parallel Port Scanner

Software CD Parallel cable Power supply

Note: The CD includes all the software you need for installing the
scanner and scanning pages, photos, and other items.
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THE PARALLEL PORT SCANNER

Document cover

Document pad

Glass
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Reference frame TN

Printer port

Host port
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Power jack

Document cover. Close the document cover after placing items on the scanner glass.
Document pad. Helps to secure the document in place on the scanner glass.
Glass. Place items face down on the glass, aligned at the lower left corner.

Reference frame. Place items face down within this frame. Markings for inches and
centimeters appear along the border of the frame.

Printer port. Plug your printer cable into this port.

Host port. Plug the parallel cable that connects the scanner to the computer into this
port.

© 6 6600

Power jack. Plug the scanner’s power supply into this jack.

Note: The scanner does not have an on/off switch. Simply start a software
application that supports scanning and scan from it. For more information, see
“Setting Up the Scanner” on page 7.
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WHAT You NEED

To use the scanner and software, you need the following:
= IBM PC (or 100-percent compatible) Pentium or equivalent

= Microsoft Windows 98 or Windows 2000

= One available parallel (LPT) port on your computer

= 32 megabytes (MB) or more of available internal memory (RAM)
= 70 MB of free hard disk space

= A VGA or SVGA monitor. Recommended settings for your monitor
are as many colors as possible—High Color (16-bit), True Color
(24-bit or 32-bit). Set the resolution to at least 800 by 600 pixels.
To set your monitor’s colors and resolution, open the Windows
Control Panel, double-click Display, and then click the Settings tab.

= A CD-ROM drive

GETTING THE PAPERPORT ONLINE DOCUMENTATION

The Installation CD also includes your ScanSoft PaperPort Online
Documentation. This manual provides more detailed information about
PaperPort’s features. Please see the CD to view the manual. You can also
print the manual from the CD.

GETTING HELP

The PaperPort software includes a complete help system that answers
questions about the scanner and its software. If you have questions, or
the scanner doesn't seem to work correctly, please use the help.

To get help while using the PaperPort software:

» Press the F1 key, or from the Help menu, choose PaperPort Help
Topics to display the Help Topics window.
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CONNECTING THE SCANNER TO THE COMPUTER

Your parallel port scanner connects to any available parallel (LPT) port.
Check your computer’s manual for the parallel port locations.

Note: Please follow the sequence of steps in this section. Do not
connect the power cable until all other connections are complete.

To connect the parallel port scanner:
1. Save any open files, then shut down the power to your computer.
2. If a printer cable is attached to your computer’s parallel port,

unplug the cable from the computer. If you don't have a printer
attached to your computer, skip this step.

3. Plug one end of the scanner’s parallel cable into the port on the
back of the scanner marked “Host.”
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4. Plug the other end of the scanner’s parallel cable into the parallel
port on the back of your computer.

On some older computers the serial port and parallel port both
have 25-pin connectors that fit the scanner cable. Please make sure
you plug the scanner cable into a parallel port.

5. If you unplugged a printer from the computer’s parallel port earlier,
plug it into the “Printer” port on the scanner.

|

6. Plug the power adapter into the jack on the scanner and then into a
wall outlet.

When you plug the scanner’s power adapter into a wall outlet an
amber light indicates that the scanner is receiving power. The light
remains amber until the scanner and computer are communicating
properly. Then the light turns green.
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7. Turn on your computer. Youre now ready to install the software.

INSTALLING THE SCANNER SOFTWARE

Install the scanner software after connecting the scanner to your
computer.

To install the scanner software:
1. Start Microsoft Windows 98 or Microsoft 2000 and make sure that
no other applications are running.

2. Insert the CD into your computer’s CD-ROM drive. The CD
automatically starts.

Note: If the CD does not automatically start, make sure the CD
drive’s door is completely shut. If the CD still doesn't start, click the
Windows icon that shows the drives on your computer. (Usually, the
icon is named My Computer.) The window shows the drives available
on your computer. Double-click the icon for your CD-ROM drive to
see the list of files on the CD. Double-click the file named
START32.EXE. The CD starts.

3. Follow the instructions on the screen to install the PaperPort
software on your computer.

4. When the software installation is finished, install the other software
applications on the CD to your computer.

5. Remove the CD from your computer and store it in a safe place.
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SETTING UP THE SCANNER

The steps to set up the scanner identify the type of scanner you have and
prepares the PaperPort software to scan with it.

To set up the scanner:

1. If the PaperPort software isn't currently running, double-click the
PaperPort icon on the Windows Desktop to start it. The PaperPort
Desktop appears.

2. From the File menu, choose Select Source. The Select Source
dialog box appears, listing all Twain devices installed on your
computer.

|§ Select j
Caneel |

Twain devices include scanners, digital cameras, and other
equipment that can capture images for your computer. Twain is a
standard method that computers use to receive images from those
devices.

3. Choose the Parallel Scanner 3300, and then click Select.

Your scanner is now set to scan.

Note: You don't need to complete Steps 2 and 3 again, unless you
change the selected source to another Twain device.
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SCANNING AN ITEM

You can scan many types of items, from small business cards to A4-sized
pages. Your scanner also has special settings for scanning color photos
and text documents. For more information about scanner settings, see
“Adjusting Scanner Settings” on page 11.

To scan an item:

1. If the PaperPort software isn't currently running, double-click the
PaperPort icon on the Windows desktop to start it.

The PaperPort Desktop appears.

2. Open the scanner cover, place the item you want to scan face down
aligned at the lower left corner of the scanner glass, and close the
cover.

3. Click the Twain icon on the PaperPort software’s Command Bar,
or choose Acquire from the File menu.

The Scan Manager window appears.
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4. From the list of Scanner Settings labeled “Scan Page For,” select the
most appropriate setting for the item you're scanning. In the
example above, the selected setting is “Color Document-Faster.”

5. Click the Preview button.

The scanner scans a preview of the item on the scanner glass and
displays it in the Scan Manager window. In the following example,
the picture being scanned is a close-up of a friendly cow.

6. You can now fine-tune the options on the Scan Manager window
for the item you're scanning.

Select another
scanner setting if
you think it’s
more appropri-
ate for the item
being scanned.

Select other set-
tings here ifyou —
think they are

more appropriate

for the item being
scanned. You also

use these settings

to customize a

scan setting.
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Click Scan to scan the
item and display it in
the application.

Click Preview to check the
image again until it's what
you want for scanning.
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Check the preview image. If you want to change the scanner setting
for the item, click one of the options in the list to “Scan Page For.”

For example, to scan a black and white image instead of a color
photo, select Black & White Photo in the list.

See the table in the section “Selecting a Predefined Scanner Setting”
on page 12 for a description of these predefined settings.

You can also select from the Scan Configuration options.
Select the area of the item you want to scan.

When you preview an item to scan, the selection rectangle around
the image indicates the scan area. However, you may want to select
only a certain area of an item to scan. Selecting an appropriate scan
area can result in a faster scan and a smaller file size.

The scanned image’s file size and available space on your computer’s
hard drive are shown at the bottom left side of the Scan Manager
window.

To select the area you want to scan, drag the borders of the selection
rectangle around the preview image to reduce or enlarge the area.

If you want to preview the item again with the new settings, click
the Preview button.

When you are satisfied with the preview, click the Scan button.

The scanned item appears as a thumbnail image in the ScanSoft
PaperPort Desktop.
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Thumbnail image
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Note: For additional details about the Scan Manager’s features click
the Help button on the Scan Manager.

ADJUSTING SCANNER SETTINGS

You can adjust the scanner settings to fine tune the scanned item.
This section tells you how to:

Select a predefined scanner setting.

Select scan configuration options.

Customize a scanner setting.

Adjust the brightness and contrast.

Select the area of the item you want to scan.
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SELECTING A PREDEFINED SCANNER SETTING

In the Scan Manager window, you can select one of the predefined
scanner settings from the list “Scan Page For.” The settings are described
in the following table.

Scan Page For | Default Setting | To Scan Description
Editing Text Black-and-white | Business letters, Enhances the use of OCR
(OCR) 300 dpi contracts, memos, and | software for converting item
other documents that text to editable text. Provides
you want to edit higher quality and a larger file
size than the Faxing, Filing or
Copying scan setting.
Faxing, Filing, | Black-and-white | Newspaper and Provides the fastest scan time
or Copying 200 dpi magazine articles, and smallest file size.
receipts, forms, and
other text items
Black & White | Grayscale Black-and-white photos | Provides the best setting for
Photo 100 dpi black-and-white photos.
Color Color Color pages with many | Creates a reasonable scanned
Document— | 100 dpi graphics, or mixed color item in a file that is not
Faster graphics and text, line too large. This is the scanner’s
art, or photos that default setting.
require a quick scan
Color Color Photographs and color | Provides the ideal setting for
Document— | 200 dpi items color items, item editing,
Better Quality desktop publishing, and high-
quality output. Results in a
color scan with slower scan
time and a larger file size.
Custom Color Any item You select all the options for
100 dpi scanning. Also used to create

and add a new scan setting to
the list.
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Color Grayscale B&W

Selecting the proper scanner setting before scanning produces the best
results for a scanned item. The scanner setting determines the resolution
of the item and the number of possible shades of gray or color. The
symbols next to the setting names indicate the scan mode—color,
grayscale, or black and white. The scanner settings affect the speed of
the scan and the file size. The Scan Manager window shows the
approximate file size of a scanned item to help you decide whether to
use a particular scanner setting.

Note: Your scanner is initially set to scan with the setting Color
Document—Faster. To scan at a higher resolution, select Color
Document—Better Quality. Note, however, that scanning at a higher
resolution creates a larger file size, takes longer to scan, and may not
print any better. To minimize the file size and the time required to get
a better quality scan, select just the area of the item that you want to
scan. For more information about selecting the area of an item, see
“Selecting the Area of the Item You Want to Scan” on page 16.

SELECTING SCAN CONFIGURATION OPTIONS

The scan configuration options provide you with additional settings
when scanning an image. Note that when you select one of the
predefined scanner settings, these options show what is already selected
for that setting, but you can change them as you wish.

The options are:

Mode—Shows the scan mode such as color, grayscale, and black-and-
white. Click the drop-down arrow to see your choices for the scan
mode. The symbols next to the selections indicate their mode setting.
Choose one of the modes for scanning from the list.

Res—This is the resolution setting for the scan in dots-per-inch (dpi).
The higher the dpi, the sharper the image. But higher dpi settings also
produce larger files sizes. Usually the higher resolution settings are used
for precision work, such as photographs or fine artwork. Click the drop-
down arrow and choose one of the resolution settings from the list.
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Size—The page size for the image. If you want to use one of the preset
sizes, click the drop-down arrow and choose the size from the list. If you
want to create a custom size, click on the picture window and drag the
mouse. A dotted box on the window indicates the page size, and the two
number boxes—with the vertical and horizontal symbols next to
them—show the actual page size in inches. You can also enter the
vertical and horizontal sizes in those two number boxes. To set the units
for the sizes, click the drop-down arrow for the size units. The choices
are inches, cm (for centimeters), and pixels.

AutoCrop—Select this option to let the scanner automatically
determine the size of the item being scanned. For example, if you put a
photo in the middle of the glass, the scanner will automatically
determine the size of the photo. When AutoCrop is selected, the
scanner makes two passes—the first pass senses the item’s size, and the
second pass scans the image. This option overrides the selections for
Size.

Adv. Settings—Click this button to see advanced settings for scanning.
See the online Help information for details about the advanced settings.
CUSTOMIZING A SCANNER SETTING

You can create custom settings to add to the list of options on the Scan
Manager.

Note: Predefined settings can not be customized.

To create a new scanner setting:

1. Inthe Scan Page For options, select Custom to create a new
scanner setting.

2. Inthe Scan Configuration options, select the options you want for
your custom setting.

3. If you want to adjust the advanced settings for your custom setting,
click the Adv. Setting button. Click the Help button to see more
information about the advanced settings.
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Drag to adjust brightness

Drag to adjust contrast
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4. Click the Save As button.

The Save As dialog box appears.
5. Type a name for the new scanner setting.
6. Click Save.

The new setting is added to the list of “Scan Page For” options at the
top of the dialog box.

ADJUSTING THE BRIGHTNESS AND CONTRAST

Sometimes an item is scanned with the brightness and contrast set to be
too light or too dark. For example, a note written with a light pencil
may need to be scanned darker to improve legibility.

You can adjust the brightness and contrast at which grayscale and color
items are scanned. You can also adjust the brightness for black-and-
white items.

To adjust brightness and contrast:

1. Click the Adv. Settings button on the Scan Manager window. The
Advanced Settings dialog box appears.

™ Diafeail wmitng
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2. Select the User Defined option.
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Drag the Brightness slider to the left to make the item darker or to
the right to make the item lighter.

Drag the Contrast slider to the left to decrease the contrast or to
the right to increase the contrast.

Click OK on the Advanced Settings dialog box.

Note: For more detailed information on advanced settings, click the
Help button on the Scan Manager.

SELECTING THE AREA OF THE ITEM YOU WANT TO SCAN

When you preview an item to scan, the selection rectangle around the
image indicates the scan area. However, you may want to select only a
certain area of an item to scan. Selecting an appropriate scan area can
result in a faster scan and a smaller file size.

To select the area you want to scan:

1.

5.

Click the Preview button. An image of the scanned item appears in
the Preview area. A selection rectangle shows the current scan area.

(optional) In the Scan Configuration settings, select the units of
measure you want to use for the scan area. You can select either
inches, centimeters, or pixels.

To change the dimensions of the rectangle, click the rectangle, and
then drag the borders of the rectangle to resize it. This effectively
allows you to crop the item. The dimensions of the selected area
appear in the Scan Configuration settings.

You can also type length and width dimensions directly into the
boxes that show the dimensions of the selection area. Use this
process to produce a precise scan area size.

To position the rectangle over the area you want to scan, click and
hold the left mouse button and drag to the location desired.

Click the Scan button to scan the image.
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CLEANING THE SCANNER GLASS

Scanning items that have excessive amounts of dirt or dust may dirty the
glass. To ensure the best quality scanned item, wipe the scanner glass
with a soft clean cloth to rid the glass of dust or other debris.
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PARALLEL PORT SCANNER SPECIFICATIONS

Bit Depth

Scanning resolution

Maximum ltem sizes
Scanner dimensions
Height

Width

Length

Weight

Operating temperature
Relative humidity
Power supply

Input voltage/frequency

Output voltage/watt

Safety and agency certifications

Hardware warranty

36-Bit color (internal), 12-Bit gray
(internal), 1-Bit line art/text

Optical resolution:

600 x 1200 dpi

Maximum resolution (interpolated):
2400 x 2400 dpi

8.5 x 11.69 inches (21.6 x 29.7 cm)

3.4 inches (8.5 cm)

11.4 inches (29.0 cm)

17.5 inches (45.0 cm)

5.6 pounds (2.5 kg)

50°-104° F (5°-35° C without condensation)
20%-80% (@35° C without condensation)

100 Vac, 50/60 Hz (Japan)

120 Vac, 60 Hz (North America)
230 Vac, 50 Hz (Europe)

12 V DC, 15 watt maximum
UL, ULc, FCC Class B,

VCCI Class B, CE

One-year limited warranty

18
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